


Excel Chapter 2 - Formulas, Functions, Formatting, and Web Queries  

 
MULTIPLE CHOICE 

 

 1. To start a new line in a cell, press ____ after each line, except for the last line, which is completed by 

clicking the Enter box, pressing the ENTER key, or pressing one of the arrow keys. 

a. ALT+ENTER c. SHIFT+ENTER 

b. CTRL+ENTER d. TAB+ENTER 
 

 

ANS: A PTS: 1 REF: EX 87 

 

 2. If a cell has a two-digit year of 32, Excel automatically changes it to a four-digit year of ____. 

a. 1732 c. 1932 

b. 1832 d. 2032 
 

 

ANS: C PTS: 1 REF: EX 88 

 

 3. To save a previously saved workbook with a new name or on a different drive, ____. 

a. click the Save button on the Quick Access Toolbar 

b. click Save As on the File menu 

c. press CTRL+S 

d. click Save on the File menu 
 

 

ANS: A PTS: 1 REF: EX 90 

 

 4. All of the following are valid Excel arithmetic operators except ____. 

a. ^ c. % 

b. * d. > 
 

 

ANS: D PTS: 1 REF: EX 92 

 

 5. When Excel follows the order of operations, the formula, 8 * 3 + 2, equals ____. 

a. 40 c. 48 

b. 26 d. 13 
 

 

ANS: B PTS: 1 REF: EX 92 

 

 6. Every time you enter a value into a cell in the worksheet, Excel automatically ____ formulas. 

a. recalculates new c. recalculates old 

b. recalculates some d. recalculates all 
 

 

ANS: D PTS: 1 REF: EX 96 

 

 7. When an error occurs in a formula in a cell, Excel displays the ____ button next to the cell and 

identifies the cell with the error by placing a green triangle in the upper left of the cell. 

a. Smart Tag Actions c. Trace Error 

b. AutoCorrect Options d. Auto Fill Options 
 

 

ANS: C PTS: 1 REF: EX 96 

 

 8. The ____ button lists formatting options following an insertion of cells, row, or columns. 

a. Paste Options c. Auto Fill Options 

b. Insert Options d. AutoCorrect Options 
 

 

ANS: B PTS: 1 REF: EX 97 



 

 9. In Excel, functions can be entered using any of the following methods except the ____. 

a. Function command on the Tools menu c. Insert Function box in the formula bar 

b. keyboard or mouse d. AutoSum command on the Formulas tab 
 

 

ANS: A PTS: 1 REF: EX 98 

 

 10. How do you activate Range Finder to verify a formula in a cell? 

a. Range Finder does not verify formulas c. Double-click in the cell 

b. Press the ESC key d. Click the Range Finder button 
 

 

ANS: C PTS: 1 REF: EX 106 

 

 11. Using the ____ button on the Ribbon instructs Excel to display additional decimal places in a cell. 

a. AutoFormat c. Increase Decimal 

b. Currency Style d. Percent Style 
 

 

ANS: C PTS: 1 REF: EX 116 

 

 12. Click ____ in the Conditional Formatting gallery to display the New Formatting Rule dialog box. 

a. Rule Format c. New Format 

b. New Rule d. Format Rule 
 

 

ANS: B PTS: 1 REF: EX 119 

 

 13. When Excel starts and the blank worksheet displays on the screen, all of the columns have a default 

width of ____. 

a. 8.43 characters, or 64 pixels c. 12.75 points, or 17 pixels 

b. 64 characters, or 8.43 pixels d. 17 points, or 12.75 pixels 
 

 

ANS: A PTS: 1 REF: EX 122 

 

 14. ____ means that the width of the column will be increased or decreased so the widest entry will fit in 

the column.  

a. Auto column adjust c. Auto adjust 

b. Width fit d. Best fit 
 

 

ANS: D PTS: 1 REF: EX 122 

 

 15. To instruct Excel to display a hidden column, position the mouse pointer to the ____. 

a. left of the column heading boundary where the hidden column is located and then drag to 

the right 

b. right of the column heading boundary where the hidden column is located and then drag to 

the left 

c. left of the column heading boundary where the hidden column is located and then drag to 

the left 

d. right of the column heading boundary where the hidden column is located and then drag to 

the right 
 

 

ANS: D PTS: 1 REF: EX 122 

 

 16. If you want to increase or decrease column width significantly, you can right-click a column heading 

and then use the ____ command on the shortcut menu to change the column’s width. 

a. Column Width c. Width Adjustment 

b. Adjust Width d. Increase Column 
 

 



ANS: A PTS: 1 REF: EX 123 

 

 17. As with column widths, when you decrease the row height to 0, the row is ____. 

a. hidden c. deleted 

b. visible temporarily at the top of the 

worksheet 

d. visible temporarily on the left side of the 

worksheet 
 

 

ANS: A PTS: 1 REF: EX 126 

 

 18. To check the spelling of the text in a single cell, ____ to make the formula bar active and then click the 

Spelling button on the Review tab on the Ribbon. 

a. double-click the formula bar c. double-click the cell 

b. right-click the cell d. right-click the formula bar 
 

 

ANS: C PTS: 1 REF: EX 129 

 

 19. If a single cell is selected so that the formula bar is not active and then the spell checker is started, 

Excel checks ____. 

a. only the text in the selected cell 

b. the remainder of the worksheet, including notes and embedded charts 

c. the spelling of all sheets in the workbook 

d. the remainder of the worksheet, not including notes and embedded charts 
 

 

ANS: B PTS: 1 REF: EX 129 

 

 20. Which view allows you to create or modify a worksheet while viewing how it will look in printed 

format. 

a. Print View c. Page Layout View 

b. Normal View d. Print Layout View 
 

 

ANS: C PTS: 1 REF: EX 129 

 

 21. You can check formulas for errors by clicking the ____ button on the Formulas tab on the Ribbon. 

a. Formula Checker c. Formula 

b. Error Checking d. Error Validating 
 

 

ANS: B PTS: 1 REF: EX 129 

 



 
Figure 2-3 

 

 22. In the Print dialog box shown in the accompanying figure, the ____ instructs Excel to print the 

selected range. 

a. Selection option button c. Active sheet(s) option button 

b. Print to file check box d. Collate check box 
 

 

ANS: A PTS: 1 REF: EX 133 

 

 23. In the Print dialog shown in the accompanying figure, the ____ instructs Excel to print the worksheet 

currently on the screen or the selected worksheets. 

a. Selection option button c. Active sheet(s) option button 

b. Print to file check box d. Collate check box 
 

 

ANS: C PTS: 1 REF: EX 133 

 

 24. In the Print dialog box shown in the accompanying figure, the ____ instructs Excel to print all the 

worksheets with content in the workbook. 

a. Entire workbook option button c. Selection option button 

b. All option button d. Active sheet(s) option button 
 

 

ANS: A PTS: 1 REF: EX 133 

 

 25. In the accompanying figure, what will be printed when you click the OK button? 

a. The entire workbook c. All pages in the worksheet 

b. The active workbook d. The active worksheet 
 

 

ANS: D PTS: 1 REF: EX 133 

 

 26. Excel does not display the Print dialog box shown in the accompanying figure when the ____ is used. 

a. Print button in a dialog box c. Print button in the Preview window 

b. Print command on the File menu d. Print button on the Quick Access Toolbar 
 

 



ANS: D PTS: 1 REF: EX 133 

 

 
Figure 2-2 

 

 27. In the accompanying figure, the Page Setup button displays the ____ dialog box. 

a. Print setup for the page c. Page Setup 

b. Setup d. Page 
 

 

ANS: C PTS: 1 REF: EX 133 

 

 28. The ____ button, in the accompanying figure, allows you to view the page in larger or smaller sizes in 

the Preview window. 

a. Next page c. Page Setup 

b. Zoom d. Preview 
 

 

ANS: B PTS: 1 REF: EX 133 

 

 29. To toggle between the values version and the formulas version of a worksheet, hold down the ____ 

key. 

a. ALT key while pressing the ACCENT MARK (`) 

b. ALT key while pressing the SINGLE QUOTATION MARK (') 

c. CTRL key while pressing the ACCENT MARK (`) 

d. CTRL key while pressing the SINGLE QUOTATION MARK (') 
 

 

ANS: C PTS: 1 REF: EX 135 

 

 30. The formulas version verifies that you entered formulas, rather than ____, in formula-based cells. 

a. text c. functions 

b. numbers d. dollar signs 
 

 

ANS: B PTS: 1 REF: EX 135 

 



 31. The ____ of the worksheet shows the actual formulas you have entered, rather than the resulting 

values. 

a. Actual symbol c. formulas version 

b. current version d. Formulas Print symbol 
 

 

ANS: C PTS: 1 REF: EX 135 

 

 32. The process of finding and correcting errors in a worksheet is called ____. 

a. searching and replacing c. verifying 

b. debugging d. validating 
 

 

ANS: B PTS: 1 REF: EX 135 

 

 33. To import data stored on a Web site use a ____. 

a. Web query c. Web import 

b. Web search d. Web copy 
 

 

ANS: A PTS: 1 REF: EX 137 

 

 34. Most Excel specialists who build Web queries use the worksheet returned from the Web query as an 

engine to supply data to another ____ in the workbook. 

a. range 

b. dialog box 

c. cell 

d. worksheet 
 

 

ANS: D PTS: 1 REF: EX 137 

 

 35. What name does Excel give the first blank worksheet? 

a. Book1 c. Worksheet1 

b. Workbook1 d. Sheet1 
 

 

ANS: D PTS: 1 REF: EX 140 

 

 36. To rename sheets, double-click the sheet tab in the lower-left corner of the window, type the new sheet 

name, and then ____. 

a. click the Cancel box c. click the Name box 

b. press the ESC key d. press the ENTER key 
 

 

ANS: D PTS: 1 REF: EX 141 

 



 
Fig 2-5 

 

 37. In the accompanying figure, what is the first step in renaming the worksheet? 

a. Copy the name from an existing 

worksheet. 

c. Type the new name next to the old one. 

b. Double-click the worksheet tab. d. Delete the first worksheet in the 

workbook. 
 

 

ANS: B PTS: 1 REF: EX 141 

 

 38. In the accompanying figure, to move between worksheets, use the ____ to the left of the sheet tabs. 

a. worksheet scrolling button c. tab scrolling buttons 

b. worksheet advancing button d. sheet open-close button 
 

 

ANS: C PTS: 1 REF: EX 141 

 

 39. Longer worksheet names also can mean that ____ sheet tabs will show. 

a. fewer c. more 

b. all d. no more 
 

 

ANS: A PTS: 1 REF: EX 141 

 

 40. E-mailing a workbook from Excel sends the workbook as a(n) ____ in the e-mail. 

a. picture c. box 

b. attachment d. table  
 

 

ANS: B PTS: 1 REF: EX 143 

 



MULTIPLE RESPONSE 

 

Modified Multiple Choice 

 

 1. Which of the following are considered guidelines to use when making decisions about creating a new 

workbook? 

a. Determine the necessary formulas and 

functions needed 

c. Specify how the printed worksheet should 

appear 

b. Identify how to format various elements of 

the worksheet 

d. Enter data into the worksheets and format 

the cells 
 

 

ANS: A, B, C PTS: 1 REF: EX 85 

 

 2. Using arithmetic operation, the formula, =d4*e4, is the same as which formulas? 

a. D4 * E4 c. =D4 * E4 

b. d4 * e4 d. =d4 * e4 
 

 

ANS: C, D PTS: 1 REF: EX 92 

 

 3. You can apply conditional formatting to ____. 

a. a cell c. a range of cells 

b. the entire worksheet d. the entire workbook 
 

 

ANS: A, B, C, D PTS: 1 REF: EX 118 

 

 4. Which buttons in the Spelling dialog box will not change the spelling of the word? 

a. AutoCorrect c. Ignore Once 

b. Undo Last d. Ignore All 
 

 

ANS: C, D PTS: 1 REF: EX 128 

 

 5. Which statements are true about the Excel spell checker? 

a. It can check notes and embedded charts. c. It can check in one language and offer 

suggestions in another language. 

b. It can check all sheets in a workbook. d. When it reaches the end of the worksheet, 

it will ask if you want to continue 

checking at the beginning. 
 

 

ANS: A, B, D PTS: 1 REF: EX 129 

 
TRUE/FALSE 

 

 1. The arithmetic operator, ^, directs Excel to perform the division operation.  

 

ANS: F PTS: 1 REF: EX 92 

 

 2. Cell references in formulas must be entered in uppercase, and spaces cannot be added before or after 

arithmetic operators. 

 

ANS: F PTS: 1 REF: EX 92 

 

 3. Regardless of the length and complexity of a formula, using Point mode to enter formulas always is 

slower and less accurate than using the keyboard. 

 

ANS: F PTS: 1 REF: EX 94 



 

 4. When a formula is copied, Excel adjusts the cell references so the new formulas contain references 

corresponding to the new location and performs calculations using the appropriate values. 

 

ANS: T PTS: 1 REF: EX 96 

 

 5. A smart tag indicator is a block plus sign located in the center of the cell.  

 

ANS: F PTS: 1 REF: EX 96 

 

 6. The AVERAGE function requires that the argument (the range) be included within parentheses before 

the function name. 

 

ANS: F PTS: 1 REF: EX 98 

 

 7. When Point mode is used to enter a formula or function, the arrow keys can be used to complete the 

entry. 

 

ANS: F PTS: 1 REF: EX 100 

 

 8. Excel has more than 400 functions. 

 

ANS: T PTS: 1 REF: EX 104 

 

 9. One of the least common mistakes made with Excel is to include the wrong cell reference in a formula.  

 

ANS: F PTS: 1 REF: EX 106 

 

 10. To use Range Finder to verify that a formula contains the intended cell references, right-click the cell 

with the formula to be checked. 

 

ANS: F PTS: 1 REF: EX 106 

 

 11. Excel does not allow the contents of a cell to be aligned vertically.  

 

ANS: F PTS: 1 REF: EX 114 

 

 12. The Comma Style button is located on the Ribbon. 

 

ANS: T PTS: 1 REF: EX 115 

 

 13. When using conditional formatting, if the condition is true, then Excel applies the formatting.  

 

ANS: T PTS: 1 REF: EX 118 

 

 14. With conditional formatting, if the value of the cell changes and no longer meets the specified 

condition, Excel suppresses the conditional formatting. 

 

ANS: T PTS: 1 REF: EX 121 

 

 15. A character is a dot on the screen that contains a color.  

 

ANS: F PTS: 1 REF: EX 122 



 

 16. A pixel is defined as a letter, number, symbol, or punctuation mark in 10-point Arial font, the default 

font used by Excel. 

 

ANS: F PTS: 1 REF: EX 122 

 

 17. The default row height in a blank worksheet is 12.75 points (or 17 pixels).  

 

ANS: F PTS: 1 REF: EX 122 

 

 18. To skip correcting a word identified by the spell checker, click the Ignore Once button in the Spelling 

dialog box. 

 

ANS: T PTS: 1 REF: EX 128 

 

 19. If a cell other than cell A1 is selected before starting the spell checker, Excel will display a dialog box 

when the spell checker reaches the end of the worksheet, asking if the spell checker should continue 

checking at the beginning. 

 

ANS: T PTS: 1 REF: EX 129 

 

 20. You can preview a worksheet using the Print Preview button on the menu bar.  

 

ANS: F PTS: 1 REF: EX 133 

 

 21. To import external data from a World Wide Web site, it is necessary to have access to the Internet. 

 

ANS: T PTS: 1 REF: EX 137 

 



 
Figure 2-1 

 

 22. In the accompanying figure, the two middle scroll buttons to the left of the sheet tabs move to the first 

or last worksheet in the workbook.  

 

ANS: F PTS: 1 REF: EX 141 

 

 23. In the accompanying figure, the leftmost and rightmost scroll buttons to the left of the sheet tabs move 

one worksheet to the left or right. 

 

ANS: F PTS: 1 REF: EX 141 

 

 24. The tabs at the bottom of the worksheet window, in the accompanying figure, allow any of the 

worksheets in the workbook to be viewed. 

 

ANS: T PTS: 1 REF: EX 141 

 

 25. When a workbook is sent as an attachment to an e-mail, the recipient can double-click the attachment 

to open it in Excel, or save it on disk and then open it at a later time.  

 

ANS: T PTS: 1 REF: EX 143 

 
COMPLETION 

 

 1. The ____________________ preceding a formula is important because it alerts Excel that a formula or 

function is being entered and not text. 

 



ANS: equal sign 

 

PTS: 1 REF: EX 91 

 

 2. Excel places a small purple triangle, called a(n) ____________________, in a cell to indicate that a 

smart tag is available. 

 

ANS: smart tag indicator 

 

PTS: 1 REF: EX 96 

 

 3. A blank cell in Excel has a numerical value of ____________________. 

 

ANS:  

zero 

0 

 

PTS: 1 REF: EX 98 

 

 4. The values used with a function are called ____________________. 

 

ANS: arguments 

 

PTS: 1 REF: EX 98 

 

 5. The ____________________ function sums the numbers in the specified range and then divides the 

sum by the number of non-zero cells in the range. 

 

ANS: AVERAGE function 

 

PTS: 1 REF: EX 99 

 

 6. The ____________________ function displays the highest value in a range. 

 

ANS: MAX 

 

PTS: 1 REF: EX 101 

 

 7. The ____________________ function determines the lowest value in a range. 

 

ANS: MIN 

 

PTS: 1 REF: EX 102 

 

 8. The ____________________ inserts a comma every three positions to the left of the decimal point and 

causes numbers to be displayed to the nearest hundredths. 

 

ANS: Comma style format  

 

PTS: 1 REF: EX 114 

 

 9. A(n) ____________________ is a dollar sign that appears immediately to the left of the first digit in a 

cell with no spaces. 



 

ANS: floating dollar sign  

 

PTS: 1 REF: EX 117 

 

 10. Formatting that appears only when the value in a cell meets specified conditions is called 

____________________. 

 

ANS: conditional formatting 

 

PTS: 1 REF: EX 118 

 

 11. A(n) ____________________ is defined as a letter, number, symbol, or punctuation mark in the 

default font used by Excel. 

 

ANS: character 

 

PTS: 1 REF: EX 122 

 

 12. A(n) ____________________ is a dot on the screen that contains a color. 

 

ANS: pixel 

 

PTS: 1 REF: EX 122 

 

 13. ____________________ means that the width of a column will be increased or decreased so the 

widest entry will fit in the column.  

 

ANS: Best fit 

 

PTS: 1 REF: EX 122 

 

 14. ____________________ is a technique that can be used to conceal data that might not be relevant to a 

particular report or sensitive data that others should not see.  

 

ANS: Hiding cells 

 

PTS: 1 REF: EX 122 

 



 
Figure 2-4 

 

 15. To correct a word throughout a worksheet, click the ____________________ in the Spelling dialog 

box shown in the accompanying figure.  

 

ANS: Change All button 

 

PTS: 1 REF: EX 127 

 

 16. To append words to the dictionary, click the ____________________ in the Spelling dialog box 

shown in the accompanying figure when Excel identifies the word as not in the dictionary.  

 

ANS: Add to Dictionary button 

 

PTS: 1 REF: EX 127 

 

 17. Click the ____________________ in the Spelling dialog box shown in the accompanying figure to add 

a misspelled word and its correct spelling to the list of words that Excel automatically will change.  

 

ANS: AutoCorrect button 

 

PTS: 1 REF: EX 127 

 

 18. The ____________________ of a worksheet is the version that shows the results of the formulas 

entered, rather than the actual formulas. 

 

ANS: values version 

 

PTS: 1 REF: EX 135 

 



 19. The ____________________ of a worksheet is the version that shows the actual formulas entered, 

rather than the resulting values. 

 

ANS: formulas version 

 

PTS: 1 REF: EX 135 

 

 20. ____________________ is the process of finding and correcting errors in a worksheet.  

 

ANS: Debugging 

 

PTS: 1 REF: EX 135 

 
MODIFIED TRUE/FALSE 

 

 1. The TOTAL function sums the numbers in the specified range and then divides the sum by the number 

of nonzero cells in the range.  

 

ANS: F, AVERAGE 

 

PTS: 1 REF: EX 99 TOP: Critical Thinking  

 

 2. The HIGHVALUE function displays the highest value in a range. 

 

ANS: F, MAX 

 

PTS: 1 REF: EX 101 TOP: Critical Thinking  

 

 3. The AVERAGE function displays the lowest value in a range. 

 

ANS: F, MIN 

 

PTS: 1 REF: EX 102 TOP: Critical Thinking  

 

 4. A theme is a predefined set of colors, fonts, chart styles, cell styles, and fill effects that can be applied 

to an entire workbook. 

 

ANS: T   PTS: 1 REF: EX 107 

TOP: Critical Thinking  

 

 5. A fixed dollar sign appears to the far left in the cell, often with spaces between it and the first digit; 

whereas a moving dollar sign appears immediately to the left of the first digit with no spaces.  

 

ANS: F, floating 

 

PTS: 1 REF: EX 114 TOP: Critical Thinking  

 
MATCHING 

 

Identify the letter of the choice that best matches the phrase or definition. 

a. Web query f. smart tag 

b. order of operations g. function 



c. arguments h. pixel 

d. theme i. debugging 

e. condition j. spell checker 
 

 

 1. Identifies certain actions to take on specific data in workbooks.  

 

 2. Used for importing into Excel data that is stored on a Web site.  

 

 3. Takes a value or values, performs an operation, and returns a result to 

the cell. 

 

 4. When more than one arithmetic operator is involved in a formula, Excel follows an order from left to 

right in a formula calculation.  

 

 5. A predefined set of colors, fonts, chart styles, cell styles, and fill effects that can be applied to an entire 

workbook.  

 

 6. A dot on the screen that contains a color and its size is based on the screen’s resolution.  

 

 7. If true, then Excel applies the formatting. If false, then Excel suppresses the formatting.  

 

 8. Compares words on the worksheet to words contained in its standard dictionary.  

 

 9. Values that are used with a function. 

 

 10. Finding and correcting errors in the worksheet. 

 

 1. ANS: F PTS: 1 REF: EX 96 

 

 2. ANS: A PTS: 1 REF: EX 137 

 

 3. ANS: G PTS: 1 REF: EX 98 

 

 4. ANS: B PTS: 1 REF: EX 92 

 

 5. ANS: D PTS: 1 REF: EX 107 

 

 6. ANS: H PTS: 1 REF: EX 122 

 

 7. ANS: E PTS: 1 REF: EX 118 

 

 8. ANS: J PTS: 1 REF: EX 127 

 

 9. ANS: C PTS: 1 REF: EX 98 

 

 10. ANS: I PTS: 1 REF: EX 135 

 
ESSAY 

 

 1. Excel’s strength lies in its handling of numbers and the presentation of them. Discuss some of the 

considerations to keep in mind when formatting numbers. In the discussion, include the terms fixed 

dollar sign, floating dollar sign, currency, and percent. 

 

ANS:  

Excel displays numbers using the Accounting Number Format with a dollar sign to the left of the 

number, inserts a comma every three positions to the left of the decimal point, and displays numbers to 

the nearest cent (hundredths place). Clicking the Accounting Number Format button on the Ribbon 

assigns the desired accounting number format. When you use the Accounting Number Format button 

to assign the accounting number format, Excel displays a fixed dollar sign to the far left in the cell, 

often with spaces between it and the first digit. The Accounting Number Format button assigns a fixed 

dollar sign to the numbers. 

 

To assign a floating dollar sign that appears immediately to the left of the first digit with no spaces, 

use the Currency Style in the Format Cells dialog box. The Comma Style format is used to instruct 

Excel to display numbers with commas and no dollar signs. The Comma Style format, which can be 

assigned to a range of cells by clicking the Comma Style button on the Ribbon, inserts a comma every 

three positions to the left of the decimal point and causes numbers to be displayed to the nearest 

hundredths. 

 



You can choose from 12 categories of formats. Once you select a category, you can select the number 

of decimal places, whether or not a dollar sign should be displayed, and how negative numbers should 

appear. Selecting the appropriate negative numbers format is important, because doing so adds a 

space to the right of the number in order to align the numbers in the worksheet on the decimal points. 

Some of the available negative number formats do not align the numbers in the worksheet on the 

decimal points. 

 

The Percent Style button instructs Excel to display a value as a percentage, determined by multiplying 

the cell entry by 100, rounding the result to the nearest percent, and adding a percent sign. 

 

PTS: 1 TOP: Critical Thinking  

 

 2. Discuss how to use conditional formatting, which is the feature of applying conditional operators to a 

cell, range, worksheet, or workbook.  

 

ANS:  

Excel allows an applied formatting to appear only when the value in a cell meets conditions specified 

by the user. This type of formatting is called conditional formatting.  

 

Any format can be conditionally assigned to a cell, a range of cells, a worksheet, or an entire 

workbook. If the value of the cell changes and no longer meets the specified condition, Excel 

suppresses the conditional formatting. 

 

Usually, conditional formatting is applied to a range of cells that contains values to highlight, if 

conditions warrant. For example, instructing Excel to change the color of the background of a cell if 

the value in the cell meets a condition, such as being less than 0. 

 

A condition, which is made up of two values and a relational operator, is true or false for each cell in 

the range. If the condition is true, then Excel applies the formatting. If the condition is false, then 

Excel suppresses the formatting. What makes conditional formatting so powerful is that the cell’s 

appearance can change as you enter new values in the worksheet. 

 

Conditional formatting (relational) operators include cell values that are: between or not between two 

numbers; equal to or not equal to a number; greater than or less than a number; greater than or equal 

to a number; and less than or equal to a number. 

 

PTS: 1 TOP: Critical Thinking  

 

 3. Discuss the relationship of debugging and displaying or printing the formulas version of a worksheet. 

Also describe the difference between the formulas version and the values version.  

 

ANS:  

The values version of the worksheet shows the results of the formulas entered, rather than the actual 

formulas. Excel also can display and print the formulas version of the worksheet, which shows the 

actual formulas entered, rather than the resulting values. Toggling between the values version and 

formulas version is possible by holding down the CTRL key while pressing the ACCENT MARK (`) 

key. 

 

The formulas version is useful for debugging a worksheet. Debugging is the process of finding and 

correcting errors in the worksheet. Viewing and printing the formulas version instead of the values 

version makes it easier to see any mistakes in the formulas. 

 



When changing from the values version to the formulas version, Excel increases the width of the 

columns so the formulas and text do not overflow to adjacent cells on the right. The formulas version 

of the worksheet usually is significantly wider than the values version. To fit the wide printout on one 

page, set the orientation to landscape, and the Fit to option in the Page sheet in the Page Setup dialog 

box. 

 

PTS: 1 TOP: Critical Thinking  

 
CASE 

 

Critical Thinking Questions 

 

Case 1 

Leo, owner of Leo’s Bread Company, has recently acquired Excel 2007. He would like to set up a 

workbook to track sales of different types of breads to determine which types are the most popular 

among customers. He is particularly interested in sales of rye bread, onion rolls, and bagels. Leo uses 

the Accounting Number Format with the sales numbers he enters into the cells. 

 

 1. After Leo enters the sales numbers into the cells, he decides he does not want the fixed dollar sign to 

appear on the far left of the cell, separated by white spaces from the actual value. He would prefer that 

the dollar sign appear immediately to the left of the first digit of the number. To format the location of 

the dollar sign, which category on the Number tab in the Format Cells dialog box would he select? 

a. General c. Currency 

b. Number d. Accounting 
 

 

ANS:  

C 

 

PTS: 1 REF: EX 114 | EX 116  TOP: Critical Thinking 

 

 2. The worksheets still have the default names assigned to them automatically by Excel. How would Leo 

rename the worksheets to Rye Bread, Onion Rolls, and Bagels? 

a. In cell A1, press ALT+ENTER keys 

and type the new name.  

c. Select cell A1 of the worksheet and 

type the new name. 

b. Double-click the worksheet tab, type 

the new name, and press the ENTER 

key. 

d. Click the top center cell on the 

worksheet and type the new name. 

 

 

ANS:  

B 

 

PTS: 1 REF: EX 141 TOP: Critical Thinking  

 

Critical Thinking Questions 

 

Case 2 

Anna is a competitive runner. She wants to improve her performance and decides to keep track of data 

for six months to determine if the time of day or year affects performance numbers. On a single 

worksheet, she labels the columns B through E as follows: (B) Start Time, (C) End Time, (D) Total 

Time, (E) Distance. The rows are labeled: (2) Date, (3)Maximum, (4) Average, (5) Minimum.  

 



 3. After three months, Anna wants to know the longest total time she has run, as listed in the Total Time 

column. By looking at the values in the column, she finds the longest total time to be 54 minutes. 

Instead of manually entering that value in cell D3 (Maximum Total Time), Anna decides to use the 

MAX function to determine the value rather than manually entering the 54 minutes. Why did Anna 

prefer to use the MAX function? 

a. She believes that 54 minutes is her best 

running time. 

c. She believes that 54 minutes is not her 

best running time. 

b. The MAX function recalculates the 

highest value each time a new value is 

entered into the worksheet. 

d. The MAX function provides a constant 

value that will not change for this cell 

when a new value is entered into the 

worksheet. 
 

 

ANS:  

B 
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 4. When she sets up the worksheet, Anna wants to the know the average distance she runs. What should 

she do in cell E4 to determine the average distance? 

a. Enter the text =av and then select the 

AVERAGE function from the 

AutoComplete list; then enter the cell 

range. 

c. Enter the text =function and then select 

the AVERAGE function from the 

AutoFunction list; then enter the cell 

range. 

b. Enter the text E2:E9 and then enter the 

cell range. 

d. Enter the text E2:E9/9 and then enter 

the cell range. 
 

 

ANS:  

A 
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